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Course outline
These guidelines are for designing and typesetting with epub export and
conversion in mind. They are also good design and typesetting practice even
if you’re not sure you’re going to be exporting or converting to epub. We’ll
cover:

1. Dealing with frames
2. Fonts
3. Thinking ahead about styles and tag names
4. Design considerations
5. The table of contents
6. Metadata
7. The cover
8. Exporting to epub
9. Tips

You’ll find much of these, plus updates and comments, on the Electric Book
Works Knowledge Base at electricbookworks.com/kb.

If you really want to understand why and how to best use InDesign, you
should also get to grips with epub code. For that, check out EBW’s notes on
Making ebooks with Sigil, HTML and CSS.

http://electricbookworks.com/kb
http://electricbookworks.github.io/ebw-training/making-ebooks/0-3-contents.html




Dealing with frames
The guidelines here are for designing and typesetting with epub export/
conversion in mind. They are also good design and typesetting practice even
if you’re not sure you’re going to be exporting or converting to epub.

One story flow
There are two rules of thumb for managing text flow:

1. Set each chapter in a separate document, and gather them in an InDesign
Book. (Inside an epub, each chapter will then be in a separate XHTML file.
This means the software only has to open one chapter at a time, making your
epub open more quickly and read more smoothly. Some software, like some
Sony Readers, can’t even open an XHTML file that’s bigger than 300K.) This
also creates a nice page-break effect in the final epub, without having to add a
page-break tag to the code.

2. Thread (join together) all your text frames in one story flow. If you have any
text boxes floating in your document, not threaded into the main story flow,
after export that text will appear right at the end of your epub. (If you must
have floating text boxes, anchor them, and give them their own paragraph
style. This can make it easier to fix the threading problem after export later
on.)

Note: You can break rule 1 for very short books if you really want to work in
one document only, not in a Book. You can add page-break tags to your
XHTML code and CSS file between chapters or sections.

Pagination and master pages
PDF ebooks have pages like print. But reflowable formats, like epub, have no
fixed pages as such. So there is no pagination. When you export an InDesign
file to epub, it will pretty much ignore:
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• running headers/footers and page numbers on master pages, and
• margins or page size.

So don’t put any important content on a master page.

Images and objects
Where possible, anchor your images. Like floating text boxes, any image that
isn’t anchored might not appear next to the relevant text after export to epub.
Up to CS4, unless anchored, images and objects will be placed pretty
arbitrarily in the ePub (usually at the end in random order). From CS5,
InDesign tries to guess where an image should go by its placement on the
page – but you might not want to trust it.

Adobe gives this advice for anchoring images:

Anchor each image to its own paragraph. To ensure that an image
appears between paragraphs in the EPUB file, it must be anchored to its
own paragraph by inserting an extra paragraph return and anchoring
the image to that paragraph. You can then apply a paragraph style to
the paragraph to further control the image’s position. For example, to
center an image and create some space above and below it in the EPUB
file, you center-align the paragraph and apply space before and after it.
Note: Since text wrap settings are discarded in the EPUB file, you must
use the InDesign Space Before and Space After options to add extra
space above or below an image.

You may have to work with the images after export anyway.

Also, images you’ve created using drawing tools in InDesign won’t work.
You’ll have to save these as image files (e.g. jpg or Adobe Illustrator) and
place them back in the InDesign document as anchored images.

Unfortunately, an anchored frame can’t contain other frames, so you can’t
anchor an image and a caption in the same anchored object. To add a caption,
you’re going to need to get at the XHTML code. (We won’t go into that code
here, but if you every need it, let us know; it can be done.)
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Finally, if you have very large images in your book, you may need to resize
them, because some devices can’t display images larger than 10MB. (In
InDesign CS4 you can choose to have InDesign automatically resize your
images when you export to epub, which saves you the hassle.)
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Fonts

Font file format
Choosing good fonts for ebooks is often a process of trial and error. Try to
use only fonts stored in OpenType format. Many TrueType fonts can work,
but OpenType is usually more reliable (especially in the long term, because
the Opentype file format is newer and more sophisticated).

Font licenses
When you include a font in an epub file, you’re including the entire font file.
So, technically, you’re redistributing the font (unlike in PDF, where only a
subset of the font is embedded in the file). For most fonts, this is illegal.

So, use open-licensed fonts, such as those from the Open Fonts Library. Their
licences do not restrict distributing the fonts in the epub file. For instance,
fonts that carry an SIL Open Font Licence can be freely redistributed.

The trick is finding an open font with the quality of, say, a Garamond Pro.

• Good options for text fonts are Linux Libertine, Gentium and Droid Serif.
• Google Fonts is perhaps the biggest library of open-licensed fonts.
• There are some lovely fonts with open licences at the League of Movable

Type.
• There are several excellent open-licensed fonts on FontSquirrel. Though be

sure the font has an open licence that allows you to redistribute it, sometimes
this isn’t absolutely clear. ‘Reuse’ is not the same as ‘redistribute’.

OPENTYPE VS OPEN-LICENSED
Don’t confuse Opentype, a file format, with an open-license, the legal statement
of what you can do with a font. They have nothing to do with each other.
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A note on small caps
Small caps must be carefully managed in an InDesign file if you don’t want
epub headaches later. See the EBW Knowledge Base article on small caps for
more information.

Embedding fonts
All fonts that are used should be embedded, including styled versions of fonts
(i.e. bold or italic). In order to embed:

The font family must be specifically named in a character/paragraph style The
style must be applied somewhere in the document (unused styles will not be
embedded) In InDesign CS3, a specific font weight or style (bold, italic, light,
etc.) only survives the export to epub if you create a special character style
for it that specifies both the weight/style and the font family. So you must
create a separate character style (i.e. bold, italic, underlined) for each font
family you apply these styles to. You can’t use a generic “bold” style and
apply it to different fonts. CS4 has a workaround (exporting to epub using
local formatting rather than styles), but it’s unreliable and creates messy code
in your epub, so it’s infinitely better to use style consistently.

Note: InDesign tries to encrypt (“mangle”) embedded fonts so that you can
use proprietary fonts without infringing their licenses. However, we’ve found
that Adobe’s encryption method can make epubs invalid (that is, they don’t
meet the requirements of the official specification, and as a result some
ereading software may not open them or display them properly). So we
recommend not embedding fonts in InDesign, and rather embedding open-
licensed fonts by editing the epub code by hand after export. This is really for
technically minded folk, though we do provide step-by-step instructions in
our EBW Knowledge Base.
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Thinking ahead about
styles and tag names
When exporting to epub, InDesign uses your style names as part of the tags
in the ebook’s XHTML code. Specifically, as class names. This means it is very
important to use paragraph and character style names that describe the
purpose or function of the given style, not its appearance (since appearance
might change on screen). This will also make it easier for those who work on
the book after you to understand how your book works.

If your style name for first-level headings is head_a , InDesign will tag
those headings like this:

<p class="head_a">
Your heading

</p>

Since CS4, if you’ve correctly used a Table of Contents, InDesign will give
every heading (if included in the saved TOC style used when you export to
epub) a heading tag, e.g. <h1> , <h2> etc., with a class named for your
style name. For instance:

<h1 class="head_a">
Your heading

</h1>

INDESIGN VERSIONS
From CS6, you can add or override class names for any style in the Export Tags.

CS3 doesn’t add heading tags, only <p> tags for everything, and you have to
change the tags manually in the epub after export.
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Local formatting
In InDesign CS3, only defined styles (paragraph styles, character styles and
object styles) are exported to epub; all local formatting is discarded when you
export to epub.

This means that if you want a single word or phrase in bold type, you need to
create a character style (e.g. bold_text ), and apply this character style to
all of the text that you need to be bold. If you then decided that you want
some of those words bold and italic, then you must create a second style to
apply to those words to be turned bold and italic.

From InDesign CS4, you get to choose when exporting to epub whether to
keep your local formatting or use defined styles instead. We recommend not
using local formatting for your styles, because exporting local formatting to
epub makes a mess of your XHTML and CSS code, which then makes it far
harder to change and manage text and formatting in the epub. So, it’s still
always strongly recommended to avoid any local formatting, and to only use
styles for the appearance of text.

Empty lines
Never use empty lines or empty paragraphs to create space in your books
(line spaces created by typing paragraph marks). They will just get ignored in
the XHTML of your ebook, so they are effectively lost in the epub. Instead,
use styles to add spacing before and after paragraph styles, especially
headings and blockquotes.

Search for empty paragraph marks by searching for two ‘End of paragraph’
marks, and solve each instance using the paragraph style’s before-and-after
spacing. You may need to create a few new paragraph styles for this to work
(e.g. a block quote of three paragraphs would need three separate paragraph
styles: a blockquote_first with space above, blockquote_next
with an indented first line, and a blockquote_last style with space
after.)
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Design considerations
If after InDesign you’re working on the design of your epub – that is, on the
CSS – here are some things to keep in mind from the start.

Assume you control only structure
It’s entirely possible that your user’s ereader ignore all styling instructions.
That means that it will have only your HTML to go on. If your HTMl is really
well structured, the book will probably read just fine. So: be very strict and
consistent with headings, and never rely on formatting for sense, only for
aesthetics.

Text alignment
It’s best not to use justified text. On very small screens this causes big spaces
between words, especially if text ever wraps around images. Rather use any
of Left (ragged right), Right (ragged left), or Centered alignment.

Note: Some intelligent ereading systems will override your settings either
way, to provide a good-looking, easy-reading experience for the reader. But
not all ereading systems are intelligent, so you should take the lousiest
common denominator into account!

Background colours
We’ve had mixed results trying to create an off-white ebook page. We don’t
recommend doing this, though. It’s almost always wasted time, and page
colour is now often determined by the ebook-reading device software for
difference contexts (e.g. dim or reversed out for low-light situations).
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If background colour is really important to you, the best place to change that
is in the CSS file of the epub itself (more about editing CSS later), by adding a
background colour to the body section.

Small caps
Small caps can wreak havoc with compatibility between InDesign’s print
output and what you get in an ereader.

The golden rule is that in InDesign, you should never lowercase your proper
nouns in your text just to get small caps from a font that can’t do Opentype
All Small Caps (that is, don’t change ‘the Lord said’ to ‘the lord said’). If small
caps don’t work in your epub, you’ll end up with actual lowercase.

If you’re going to need small caps, we highly recommend reading the ‘Small
caps’ article on the EBW Knowledge Base so that you’re equipped to make an
informed decision.

Superscripts and subscripts
Superscripts and subscripts can be problematic in epubs. The simplest
guideline is to use InDesign’s automatic super or sub positioning in a
character style. Do not rely on manual baseline shift and font-shrinking.
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The table of contents
Creating an automatic Table of Contents in your InDesign document gets you
a Table of Contents in your exported epub file. So always create one, even if
you don’t include it on any page in the document. You can just put it on the
pasteboard. It doesn’t even need page numbers. It just needs to list all the
headings you want in your epub’s clickable Table of Contents.

When creating your TOC in InDesign:

• Create the TOC style and save it.
• If you’re working in an InDesign Book, create the Table of Contents in your

style-source document. This is not necessarily the first document in your
Book.

Note: If you’re working in InDesign CS4 or later, this is doubly important for
another reason: upon export to epub, InDesign will then use proper heading
tags for your headings, not just <p> tags, in the XHTML. Make sure you
include all levels of heading in your TOC style in order for InDesign to tag
them all as XHTML headings, not paragraphs.

A TOC on the ‘book page’
In a reflowable ebook, you really don’t need a TOC on the actual ‘pages’ of
the book, since it’s part of the software’s navigation system. That said, if you
really want a TOC on the pages of the ebook, you can follow Adobe’s advice
on this:

If you have used the InDesign Table of Contents feature to generate a
TOC at the beginning of the book, it is discarded in the exported EPUB
file. To create a TOC that appears at the start of an eBook, manually
insert the text for the entries and then turn each entry into a hyperlink
that jumps to a specific section in the eBook. With InDesign CS4, you
can use cross-references instead of hyperlinks to create the TOC. When
you use cross-references, each TOC entry is generated from its
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destination text, so if the destination text is modified, you can easily
update its corresponding TOC entry with the new text.
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Metadata
You can add metadata in the InDesign document (Info > File information).
Include at least the title and author in the File Information, since that’s the
minimum that an epub needs in order to be a valid epub.

If you’re working in an InDesign Book (.indb), InDesign will export the
epub’s metadata from the source/master document.

For CS4, Adobe provides this guidance:

In the Description tab of the File Information dialog box, complete the
following fields:

• Document Title—Enter the title of the publication.
• Author—Enter the author’s full name.
• Description—Enter a short description of the publication.
• Keywords—Enter the keywords that describe the publication’s subject

category.
• Copyright Notice—Enter the copyright information for the publication.

The information is displayed in most eBook readers. None of the other
metadata fields are exported to an EPUB file.

Note: Using InDesign CS3, adding metadata in the InDesign document (Info >
File information) has caused problems for us with the resulting epub (usually
it doesn’t validate). Rather insert metadata into the epub’s content.opf file
after export.

TECHNICAL NOTE
Metadata in an epub should ideally follow Dublin Core formats and guidelines.
To add or edit metadata reliably, you can add metadata to the content.opf file in
the epub code after export, if you’re technically minded. (You don’t need to be a
developer, you just need to keep your wits about you.) Or use an epub editor
like Sigil.
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The cover
We recommend using the same InDesign documents for creating your print
PDFs and exporting to epub. This way, you only ever have one master
InDesign document, which is good for version control.

However, if you choose to have two versions of your InDesign document for
any reason, then you can put a cover image in your epub version in InDesign,
rather than inserting it later into the epub code.

If you choose to do this, read Adobe’s very helpful guide to working with
images in InDesign for epub. It includes this advice:

The cover for an eBook must be a single image. If your cover design is
composed of an assortment of text and image frames within InDesign,
the design elements will be linearized in the eBook. To quickly generate
a cover image, you can export the cover from InDesign as a JPEG file.
Choose File > Export, specify a name for the image, choose JPEG from
the Format menu, and then click Save. In the Export JPEG dialog box,
specify which page you want exported. For optimum display on
different screen sizes and resolutions, specify a resolution of 72 pixels
per inch (ppi) and choose Maximum from the Quality menu. Click
Export to generate the image. The final image size for the cover should
be around 600×800 pixels so that the cover looks good on a variety of
eBook readers. If the pixel dimensions of the image are not large
enough, export the image at a higher resolution. After your cover image
has been created, import it into InDesign.

and

Manage the cover with a book file. … create a separate InDesign
document for the cover image. Then combine the cover document with
any other documents that make up your book layout into an InDesign
book file (File > New > Book).

Obviously make that cover document the first document in your InDesign
Book.
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We prefer to insert our covers into the epub code after export from InDesign.
There is advice for inserting covers in epubs on the EBW Knowledge Base.
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Exporting to epub
In order to export a full book from InDesign, you must select the export
command from the “Book” panel menu, instead of the “File” menu, as it is for
documents.

Make sure that you have the “Book” panel visible (it automatically pops up
whenever you open a book in InDesign). The export tool will only export
character/paragraph styles and metadata from one document in the book.
This document can be selected from the Book panel menu as the “styling
source” document (the little symbol to the left of the document name).

EXPORT TO DIGITAL EDITIONS?
CS3 and CS4 referred to its epub export as ‘Export to Digital Editions’, because
at the time Adobe Digital Editions was the dominant epub reader around.

Some of the following export options have changed a little or been renamed
in different versions of InDesign. They should be a useful guide no matter
which version you’re using.

General options
• Add the name of the publisher.
• For CSS, choose ‘Defined Styles’.
• for ‘Bullets and Numbers’, choose ‘Map to … Lists’.

We avoid Adobe’s font embedding because it creates invalid ePubs.

Images options
Choose Optimized and high quality jpeg. Avoid gif or Automatic, they often
create problems.
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Contents options
• Select XHTML-based
• Select Include InDesign TOC entries (see the table of contents section) for

more detail)
• Select ‘Suppress Automatic Entries for Documents’.

Keith Fahlgren has written an excellent post on exporting from InDesign.
You’ll find it by searching for his name with “Choosing InDesign ePub output
options”.

CS3 tip
If you’re working in CS3, make sure the ‘bullets to text’ checkbox is ticked
when exporting to epub, not ‘map bullets to lists’.

Troubleshooting
Unfortunately, if your export fails, InDesign’s error messages are not always
helpful. Liz Castro found one error caused by having an ampersand in a URL
in your InDesign document. (InDesign doesn’t create valid XML for the
ampersand in a hyperlink.) On that note, check out Liz’s book, EPUB Straight
to the Point.)
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Tips
You might not need these, but here are some trial-and-error tips you might,
one day, find useful.

File sizes
In the early days of ebooks, no exported HTML or XHTML file in an epub
could be bigger than 300K when uncompressed (or 100K compressed). As a
rule of thumb, this is about 40000 words of a simple novel. Any longer book
had to be broken up into smaller documents (e.g. chapters). This rule is no
longer critical now that devices and apps are more powerful, but it’s good to
keep in mind. If you can follow it, your epub will be much faster, and your
user won’t have to wait ages for a chapter to load.

Multimedia
InDesign CS4 makes claims that it can handle multimedia (without you
having to get into the epub code), and we’re testing that. It doesn’t look good,
though (it was effectively broken in CS2 when Apple’s Quicktime stopped
supporting SWF, and wasn’t yet fixed at the time we wrote this).

So we still prefer to embed multimedia by editing epub code by hand. You can
find more on embedding multimedia on the EBW Knowledge Base.
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Your feedback
Training in a new, fast-changing field is hard, so we really need your honest
feedback about this course. You can give very brief answers, though the more
you can tell us the the better. You’re welcome to answer anonymously.

1. Given your expectations before the course, did you learn what you wanted to
learn?

◦ Exactly what I wanted.
◦ Mostly what I wanted.
◦ Um. A bit of both.
◦ Only a little of what I wanted.
◦ Not at all what I had in mind.

2. What was the best thing about the course?
3. What about the course most needs to change?
4. Do you have suggestions for how to fix that?
5. We know these courses are expensive. For you, was the expense:
◦ worth the investment,
◦ too early to tell, or
◦ not really worth it?

6. What did you think of the venue?
7. Assuming you had a positive experience, do you have any comments we

could use publicly?

Feedback forms are a schlep, so thank you, really. Pop in at EBW for thank-
you coffee any time.

http://goo.gl/forms/GW3tfIkXVK
http://goo.gl/forms/GW3tfIkXVK
http://electricbookworks.com/contact
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